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Packing List

 

4200-UL-LS-XX

 

Depending on the particular model, this switch matrix configuration uses up to six Model 7174A matrix cards. By using 2-wire
Local Sense and the row-column connection scheme, five instrument components of the Model 4200-SCS and a C-V meter can
be connected to the matrix. With six matrix cards, 72 pins are available for DUT. Table 1 lists the equipment that is supplied
with each of the six models. 

 

4200-UL-RS-XX

 

Depending on the particular model, this switch matrix configuration uses two to six Model 7174A matrix cards. By using 4-wire
Remote Sense and the Instrument Card connection scheme, four instrument components of the Model 4200-SCS, and a C-V
meter can be connected to the instrument card of the matrix. With six matrix cards, 30 pin-pairs are available for DUT. Table 2
lists the equipment that is supplied with each of the five models. 

 

4200-LC-LS-XX

 

Depending on the particular model, this switch matrix configuration uses up to six Model 7072 matrix cards. By using 2-wire
Local Sense and the Row-Column connection scheme, five instrument components of the Model 4200-SCS and a C-V meter
can be connected to the matrix. With six matrix cards, 72 pins are available for DUT. Table 3 lists the equipment that is supplied
with each of the six models.

 

4200-GP-RS-XX

 

Depending on the particular model, this switch matrix configuration uses up to six Model 7071 matrix cards. The
4200-GP-RS-XX uses a unique 3-pole relay that gives it remote sense capability, even when connected in the Local Sense mode.
By using the Local Sense and the Row-Column connection scheme settings, five instrument components of the
Model 4200-SCS and a C-V meter can be connected to the matrix and used in a 4-wire measurement configuration. With six
matrix cards, 72 pins are available for DUT. Table 4 lists the equipment that is supplied with each of the six models.
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Documentation summary

 

This packing list provides documentation for all the available switch matrix configurations. You only need to address the infor-
mation that applies to the model that you ordered. The information in this packing list is organized as follows: 

•

 

Supplied equipment

 

 — Describes the equipment that make up a switch matrix and provides tables that list the equipment
that is supplied with each model. 

•

 

Test systems for switch matrix configurations

 

 — Describes and illustrates the four basic switch matrix systems. 

•

 

Installation

 

 — Summarizes how to install matrix cards in the mainframe, connect the GPIB port of the mainframe to the
GPIB port of the Model 4200-SCS, and how to make signal connections to the matrix. 

•

 

Mainframe power on

 

 — Summarizes how to power on the switch mainframe. 

•

 

Using 

 

KCON

 

 to add switch matrix to the system

 

 

 

— Provides the step-by-step procedure to add your switch matrix to
the system.

 

NOTE

 

For details on using a switch matrix, refer to the “Model 4200-SCS Reference Manual,” 
Appendix B.

 

Supplied equipment

 

Tables 1 through 4 list the supplied equipment for each switch matrix configuration. For example, if you ordered the
4200-UL-LS-72 (see last column of Table 1), check that you have received a 707A switch mainframe (with light pen), six 7074A
switch cards, 72 triax cables, an IEEE-488 cable, and two triax-to-BNC adapters. The supplied equipment is summarized as
follows: 

 

Switch Mainframes

 

 — The Model 708A mainframe has one slot for one matrix card, while the Model 707A has six slots for
up to six matrix cards. The supplied mainframe is equipped with a light pen that can be used to open and close switches. 

 

Switch Cards

 

 — Each of the following matrix card types has eight rows and 12 columns: 

• Model 7174A Low Current Matrix Card — Provides 2-pole switching with 10fA typical offset current. It is equipped with
3-lug triax connectors. 

• Model 7072 Semiconductor Matrix Card — Provides two 2-pole low current paths (<1pA offset current), two 1-pole C-V
paths for characterization (DC to 1MHz), and four 2-pole paths for general purpose switching. It is equipped with 3-lug
triax connectors. 

• Model 7071 General Purpose Matrix Card — Provides 3-pole switching with <100pA offset current. It is equipped with
screw terminals and pin connectors.

 

Model 4200-TRX-3 Triax Cables

 

 — For the 7174A and 7072 switch cards, triax cables terminated with 3-slot triax connectors
are supplied for connections to DUT. Each triax cable is three meters in length. 

 

Model 7078-MTC-20 Cables

 

 — For each 7071 switch card, a 20-ft mass terminated cable terminated with 38-pin connectors
is supplied for connections to DUT. 

 

Model 7078-TRX-BNC Adapters

 

 — For the 7174A and 7072 switch cards, these 3-slot triax-to-BNC adapters allow an in-
strument equipped with BNC connectors (i.e., Model 590 CV Analyzer) to be connected to the switch card. 

 

NOTE

 

If any of the supplied equipment is missing or damaged, contact Keithley Instruments, or your 
Keithley representative, for instructions. Contact information is provided in the “Model 
4200-SCS User’s Manual.”
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NOTE

 

Configurations for Models 4200-UL-LS-12/707A, 4200-LC-LS-12/707A, and 4200-GP-RS-12/707A 
are not noted in the above configurations. These models imply that a Model 707A is used in place of 
a Model 708A in a single card system to allow for future expansion.

 

 Table 1

 

 Supplied equipment — 4200-UL-LS-XX

 

Supplied Equipment 4200-UL-LS-12 4200-UL-LS-24 4200-UL-LS-36 4200-UL-LS-48 4200-UL-LS-60 4200-UL-LS-72

 

708A Switch Mainframe 1 — — — — —

707A Switch Mainframe — 1 1 1 1 1

7174A Switch Cards 1 2 3 4 5 6

4200-TRX-3 Cables 12 24 36 48 60 72

7007-1 IEEE-488 Cable 1 1 1 1 1 1

7078-TRX-BNC Adapters 2 2 2 2 2 2

7078-PEN Light Pen 1 1 1 1 1 1

 

 Table 2

 

 Supplied equipment — 4200-UL-RS-XX

 

Supplied Equipment 4200-UL-RS-6 4200-UL-RS-12 4200-UL-RS-18 4200-UL-RS-24 4200-UL-RS-30

 

707A Switch Mainframe — 1 1 1 1

7174A Switch Cards 2 3 4 5 6

4200-TRX-3 Cables 12 24 36 48 60

7007-1 IEEE-488 Cable 1 1 1 1 1

7078-TRX-BNC Adapters 4 4 4 4 4

7078-PEN Light Pen 1 1 1 1 1

 

 Table 3

 

 Supplied equipment — 4200-LC-LS-XX

 

Supplied Equipment 4200-LC-LS-12 4200-LC-LS-24 4200-LC-LS-36 4200-LC-LS-48 4200-LC-LS-60 4200-LC-LS-72

 

708A Switch Mainframe 1 — — — — —

707A Switch Mainframe — 1 1 1 1 1

7072 Switch Cards 1 2 3 4 5 6

4200-TRX-3 Cables 12 24 36 48 60 72

7007-1 IEEE-488 Cable 1 1 1 1 1 1

7078-TRX-BNC Adapters 2 2 2 2 2 2

7078-PEN Light Pen 1 1 1 1 1 1

 

 Table 4

 

 Supplied equipment — 4200-GP-RS-XX

 

Supplied Equipment 4200-GP-RS-12 4200-GP-RS-24 4200-GP-RS-36 4200-GP-RS-48 4200-GP-RS-60 4200-GP-RS-72

 

708A Switch Mainframe 1 — — — — —

707A Switch Mainframe — 1 1 1 1 1

7071 Switch Cards 1 2 3 4 5 6

7078-MTC-20 Cables 1 2 3 4 5 6

7007-1 IEEE-488 Cable 1 1 1 1 1 1

7078-PEN Light Pen 1 1 1 1 1 1
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Test systems for switch matrix configurations

 

Figures 1 through 4 show typical test systems for the four basic switch matrix configurations. Note that the triax cables that
connect the Model 4200-SCS to the matrix card are supplied with the Model 4200-SCS. Also note that configurations using the
Model 708A mainframe use only one matrix card. 

 

4200-UL-LS-XX switch matrix configuration

 

 — The test system in Figure 1 uses local sensing. The two supplied
triax-to-BNC connectors are used to connect a C-V meter to the switch matrix. The switch matrix columns (pins) are used for
connecting to the probe station or test fixture.

 

Figure 1

 

Test system for 4200-UL-LS-XX switch matrix configuration
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4200-UL-RS-XX switch matrix configuration

 

 — The test system in Figure 2 uses remote sensing. Since 12 individual paths
are required for the instruments, they are connected to matrix columns instead of rows. The first matrix card in the system serves
as the Instrument Card. The probe station (or test fixture) is connected to the columns of the other matrix cards. The four sup-
plied triax-to-BNC connectors are used to connect the HP C-V meter to the switch matrix. 

 

Figure 2

 

Test system for 4200-UL-RS-XX switch matrix configuration
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4200-LC-LS-XX switch matrix configuration

 

 — The test system in Figure 3 uses local sensing and Model 7072 switch cards.
Rows A and B of the switch cards are the low current paths. Therefore, they are connected to the PreAmps of SMU1 and SMU2.
Rows G and H of the switch cards are optimized for C-V measurements. Therefore, they are connected to a C-V meter. 

The two supplied triax-to-BNC connectors are used to connect the C-V meter to the switch matrix. The switch matrix columns
(pins) are used for connecting to the probe station or test fixture.

 

Figure 3

 

Test system for 4200-UL-RS-XX switch matrix configuration
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4200-GP-RS-XX switch matrix configuration

 

 — The test system in Figure 4 uses remote sensing for the Model 4200-SCS
and the HP C-V meter. The 7071 switch card has screw terminals for row connections. Therefore, instruments are hard-wired
to the matrix card. Since the 7071 uses a 3-pole relay, each terminal pair of the Model 4200-SCS and the HP C-V meter shares
the same path (row) of the switch card.

The Model 590 C-V meter uses 2-wire local sensing. Therefore, a separate path (row) is used for the INPUT and the OUTPUT.
It is best to connect the FORCE and SENSE of Row G together. Likewise, connect Row H FORCE and SENSE together. The
supplied mass terminated cable(s) are used to connect matrix columns (pins) to the DUT. 

 

Figure 4

 

Test system for 4200-GP-RS-XX switch matrix configuration
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Installation

 

WARNING

 

The information in this section is intended for qualified service personnel only. Do not 
perform these procedures unless you are qualified to do so. Some of these procedures may 
expose you to hazardous voltages that could cause personal injury or death. Use caution 
when working with hazardous voltages.

To prevent electric shock, the switch mainframe and Model 4200-SCS must be turned off 
and their line power cords disconnected. Also ensure that no power is being supplied from 
other equipment to the switches.

 

Installing matrix cards in mainframe

 

NOTE

 

Input connections to the Model 7071 matrix card are typically made to the screw terminal 
strip on the PC board of the card. These connections must be made before installing the card 
in the mainframe. See “Connections to Model 4200-SCS and DUT” to connect instrumenta-
tion to the Model 7071 matrix card. 

 

WARNING

 

The mounting screws must be secured to ensure a proper chassis ground connection be-
tween the card and the mainframe. Failure to properly secure this ground connection may 
result in personal injury or death due to electric shock.

 

Use Figure 5 as a guide to install the matrix card(s) in the mainframe as follows: 

1. Remove the slot cover from the desired slot(s). 
2. Line up the card with the card guides in the slot. 
3. Slide the card into the mainframe until it is fully seated in the backplane connectors. 
4. Finger-tighten the spring-loaded mounting screws at the back of the card to lock it in place. 

 

Figure 5

 

Installing a matrix card

 

Matrix expansion

 

When using the Model 707A mainframe, the rows of installed matrix cards must be connected to create a single matrix. Each
switch card is an 8 (rows) x 12 (columns) matrix. With matrix rows connected, a two-card system results in an 8 x 24 matrix.
Each additional daisy-chained card in the system adds 12 columns to the matrix. 

 

4200-UL-LS-XX and 4200-UL-RS-XX

 

Model 7174A matrix cards

 

 — Supplied coaxial jumpers are used to connect the eight rows of the matrix cards installed in the
mainframe. To install the jumpers, refer to the “Model 7174A Instruction Manual.” 

Card Handle

Mounting Screws
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4200-LC-LS-XX

 

Model 7072 matrix cards

 

 — Rows C through F of the installed cards are automatically connected through the backplane of
the mainframe. Supplied jumpers are used to connect Rows A, B, G and H. To install the jumpers, refer to the “Model 7072
Instruction Manual.”

 

4200-GP-RS-XX

 

Model 7071 matrix card

 

 — The matrix rows of the installed cards are automatically connected through the backplane of the
mainframe. No additional connections are required. 

 

System connections

 

Connect the GPIB port of the Model 4200-SCS to the GPIB port of the Model 707A using a Model 7007-1 or 7007-2 cable as
shown in Figure 6. 

 

Figure 6
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Connections to Model 4200-SCS and DUT

 

The triax cables supplied with the Model 4200-SCS are used to connect the SMUs and GNDU to the switch matrix. The cables
supplied with the switch matrix configuration are used to make connections to DUT. 

 

NOTE

 

For details on connecting the switch matrix to a probe station, see “Model 4200-SCS 
Reference Manual,” Appendices G, H, and I.

 

Signal connections for 4200-UL-LS-XX, 4200-UL-RS-XX, and 4200-LC-LS-XX

 

NOTE

 

For details on connections, refer to the “Model 7174A or 7072 Instruction Manual.” 

 

Input connections

 

 — Model 7174A and 7072 matrix cards are equipped with 3-lug triax connectors. As shown in Figures 1,
2, and 3, use the triax cables supplied with the Model 4200-SCS to connect it to the first card in the switch matrix. For instru-
ments that use BNC connectors (i.e., Model 590) use the supplied triax-to-BNC adapters to make the input connections. 

 

DUT connections

 

 — Model 4200-TRX-3 triax cables are provided for connections to DUT. Figures 7 and 8 show how to make
typical connections to a DUT installed in a test fixture that is equipped with 3-lug triax connectors. For direct connections to
the DUT, you can cut off one of the triax connectors on each triax cable. The center conductor of the cable is HI (H), the inner
shield is Guard (G) and the outer shield is Common (C). 

 

NOTE

 

If using the Keithley Model 8006 Component Test Fixture, refer to the “Model 4200-SCS 
User’s Manual,” Section 2, for details on connections. 

 

Figure 7

 

Typical DUT connections for the 4200-UL-LS-XX and 4200-LC-LS-XX 
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Figure 8

 

Typical DUT connections for the 4200-UL-RS-XX

 

4200-GP-RS-XX signal connections
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For details on connections, refer to the “Model 7071 Instruction Manual.”
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Figure 9

 

Input connections for 4200-GP-RS-XX 
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DUT connections

 

 — Model 7078-MTC-20 cable is used to make connections to DUT. One 7008-MTC-20 is supplied with
each 7071 matrix card. Cutting this cable in half provides two modified cables that allow direct connection to DUT. Each cable
accommodates 12 columns. 

Figure 10 shows how to make typical connections to a DUT. Terminal identification for the mass terminated cables is provided
in the “Model 7071 Instruction Manual.”

 

Figure 10

 

Typical DUT connections for the 4200-GP-RS-XX
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Using 

 

KCON

 

 to add switch matrix to the system

 

NOTE

 

The following procedure assumes that the Model 4200-SCS is powered on with KITE open. 
See “Details to power-on the Model 4200-SCS” in the Model 708A or 707A Instruction 
Manual.

 

In order for the Model 4200-SCS to control a switch matrix, the switch matrix must be added to the test system. The switch
matrix is added using the KCON (Keithley CONfiguration utility).

The switch matrix can be used with a test fixture to test discrete DUT, or with a probe station to test a wafer. The test fixture or
probe station is also added to the system configuration using KCON. 

 

Step 1. Close 

 

KITE

 

 and open 

 

KCON

 

Close 

 

KITE

 

 by clicking the close button (

 

X

 

) at the top right-hand corner of the 

 

KITE

 

 window. If you have made changes, you
will be prompted to save them. On the windows desktop, double-click the 

 

KCON

 

 icon to open 

 

KCON

 

. 

 

Step 2. Add test fixture or probe station

 

NOTE

 

Using a switch matrix requires a test fixture or probe station in the system configuration. 
However, both cannot be in the system configuration together. See “Removing test fixture or 
probe station from the system” at the end of this procedure.

 

Add a test fixture

 

Perform the following steps to add a test fixture to the system configuration: 

1. As shown in Figure 11, select 

 

Test Fixture

 

 

 

from the 

 

Tools

 

 menu. 

2. From the 

 

Model

 

 drop-down menu in the 

 

Test Fixture Properties

 

 window (Figure 12), select a test fixture. The three 
test fixture options from the menu include: 

•

 

Generic Test Fixture

 

 — For this test fixture, specify the 

 

Number of Pins

 

 in the test system (12, 24, 36, 48, 60, or
72). Figure 12 shows the pin number settings for all the switch matrix configurations. 

•

 

Keithley Model 8006

 

 — For this test fixture, the number of pins will be fixed at 12. Figure 12A lists the switch ma-
trix configurations that use 12 pins. 

•

 

Keithley Model 8007

 

 — For this test fixture, the number of pins will be fixed at 72. Figure 12F lists the switch matrix
configurations that use 72 pins. 

 

Figure 11

 

Tools menu to add test fixture
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Figure 12

 

Test fixture properties
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A. 4200-UL-LS-12
4200-UL-RS-6
4200-LC-LS-12
4200-GP-RS-12

C. 4200-UL-LS-36
4200-UL-RS-18
4200-LC-LS-36
4200-GP-RS-36

E. 4200-UL-LS-60
4200-UL-RS-30
4200-LC-LS-60
4200-GP-RS-60

F. 4200-UL-LS-72
4200-LC-LS-72
4200-GP-RS-72

E. 4200-UL-LS-60
4200-UL-RS-30
4200-LC-LS-60
4200-GP-RS-60

D. 4200-UL-LS-48
4200-UL-RS-24
4200-LC-LS-48
4200-GP-RS-48

B. 4200-UL-LS-24
4200-UL-RS-12
4200-LC-LS-24
4200-GP-RS-24
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Add a probe station

 

Perform the following steps to add a probe station to the system configuration: 

1. As shown in Figure 13, add the 

 

Probe Station

 

 

 

using the 

 

Tools

 

 menu. 

2. From the 

 

Model

 

 drop-down menu in the Prober 

 

Properties

 

 window (Figure 14), select a probe station. Supported 
probe stations include the following: 

• Fake Prober

• Manual Prober

• Micromanipulator 8860 Prober

• Karl-Suss PA200 Prober

 

NOTE

 

Contact Keithley for the most up-to-date list of supported probers. If using an unsupported 
prober, you will have to create a user library and module to control it. 

 

3. Using Figure 14 as a guide, specify the 

 

Number of Pins / Positioners

 

 for your switch matrix configuration (12, 24, 
36, 48, 60, or 72). 

 

Figure 13

 

Tools Menu to add a probe station
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Figure 14

 

Prober properties
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A. 4200-UL-LS-12
4200-UL-RS-6
4200-LC-LS-12
4200-GP-RS-12

C. 4200-UL-LS-36
4200-UL-RS-18
4200-LC-LS-36
4200-GP-RS-36

F. 4200-UL-LS-72
4200-LC-LS-72
4200-GP-RS-72

E. 4200-UL-LS-60
4200-UL-RS-30
4200-LC-LS-60
4200-GP-RS-60

D. 4200-UL-LS-48
4200-UL-RS-24
4200-LC-LS-48
4200-GP-RS-48

B. 4200-UL-LS-24
4200-UL-RS-12
4200-LC-LS-24
4200-GP-RS-24
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Step 3. Add switch mainframe

 

Add the switch mainframe (Model 708A or 707A) to the system using the 

 

Tools

 

 menu as shown in Figure 15. The switch system

 

Properties

 

 tab will then be displayed. 

 

Figure 15

 

Add 708A or 707A to test system

 

Step 4. Set switch system properties

 

Switch system properties are set from the 

 

Properties

 

 tab. Figures 16 through 19 show the 

 

Properties

 

 tab for the various switch
matrix configurations.

 

GPIB address

 

The 

 

Properties

 

 windows in Figures 16 through 19 show the GPIB address of the Model 708A set to 19 and the GPIB address
of the Model 707A set to 18. These are the factory set address values for the mainframes. 

The address value in the 

 

Properties

 

 tab area must match the actual GPIB address setting of the mainframe. The GPIB (IEEE)
address of the mainframe is displayed briefly during its power on sequence. In the 

 

Properties

 

 tab area, the address value can be
changed from the drop-down menu for the 

 

GPIB Address

 

. To change the address on the 707A/708A Mainframe, see the
“707A/708A Instruction Manual.”

��������������������� �!"# �$

��������������������� �!"# �$A. Add 708A switch mainframe

B. Add 707A switch mainframe
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4200-UL-LS-XX switch system properties

 

In Figure 16, use the appropriate 

 

Properties

 

 tab as a guide to set the properties. Under 

 

Instrument Connection Scheme

 

, select

 

Row-Column

 

 and 

 

Local Sense

 

. From the drop-down windows for the 

 

Switch Cards

 

, select 

 

Keithley 7174 Low Current Ma-
trix Card

 

 

 

for the indicated slot(s). 

 

NOTE

 

If one or more slots are set for a matrix card other than the Model 7174A, then all slots must 
first be set to 

 

Empty

 

 before they can be set to 

 

Keithley 7174 Low Current Matrix Card

 

. 

 

Figure 16

 

Switch system settings for 4200-UL-LS-XX
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4200-UL-RS-XX switch system properties

 

In Figure 17, use the appropriate 

 

Properties

 

 tab as a guide to set the properties. Under 

 

Instrument Connection Scheme

 

, select

 

Instrument Card

 

 and 

 

Remote Sense

 

. From the drop-down windows for the 

 

Switch Cards

 

, select 

 

Keithley 7174 Low Current
Matrix Card

 

 for the indicated slots. 

NOTE If one or more slots are set for a matrix card other than the Model 7174A, then all slots must first 
be set to Empty before they can be set to Keithley 7174 Low Current Matrix Card. 

Figure 17
Switch system settings for 4200-UL-RS-XX

�����

�����
�����
�����

����	
����
��������������������������

����	
����
��������������������������

����������	��
�
 ����������	��
���

�����
�����
�����

����	
����
��������������������������

����	
����
��������������������������

����������	��
���

�����
�����

����	
����
��������������������������

����	
����
��������������������������

����������	��
���

�����

����	
����
��������������������������

����	
����
��������������������������

����������	��
���

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������

����	
����
��������������������������
����	
����
��������������������������
����	
����
��������������������������

����
���������	
���������������� 	��!���"��� ����
���������	
���������������� 	��!���"��� ����
���������	
���������������� 	��!���"���

����
���������	
���������������� 	��!���"��� ����
���������	
���������������� 	��!���"���

��������
��
 ��������
���� ��������
����

��������
���� ��������
��	�

A. 4200-UL-RS-6 B. 4200-UL-RS-12 C. 4200-UL-RS-18

D. 4200-UL-RS-24 E. 4200-UL-RS-30
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4200-LC-LS-XX switch system properties

In Figure 18, use the appropriate Properties tab as a guide to set the properties. Under Instrument Connection Scheme, select
Row-Column and Local Sense. From the drop-down windows for the Switch Cards, select Keithley 7072 Matrix Card for
the indicated slot(s). 

NOTE If one or more slots are set for a matrix card other than the Model 7072, then all slots must 
first be set to Empty before they can be set to Keithley 7072 Matrix Card. 

Figure 18
Switch system settings for 4200-LC-LS-XX
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4200-GP-RS-XX switch system properties

In Figure 19, use the appropriate Properties tab as a guide to set the properties. Under Instrument Connection Scheme, select
Row-Column and Local Sense. From the drop-down windows for the Switch Cards, select Keithley 7071 Matrix Card for
the indicated slot(s). 

NOTE If one or more slots are set for a matrix card other than the Model 7071, then all slots must 
first be set to Empty before they can be set to Keithley 7071 Matrix Card. 

Figure 19
Switch system settings for 4200-GP-RS-XX
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Step 5. Set matrix card properties
The navigator for the system configuration is provided on the left side of the KCON window. Figure 20 shows an example of
the System Configuration Navigator. When a test fixture, switch mainframe, and matrix cards are added to the system, they ap-
pear in the navigator. The navigator in Figure 20 shows a switch system that uses six Model 7174A matrix cards. 

The properties for each matrix card in the switch system must be set. A card properties tab is opened by clicking the card entry
in the navigator. For example, clicking KI 7174 Matrix Card - CARD 1 in Figure 20 opens the Properties tab for that card. 

Figure 20
System Configuration Navigator (example)

Card properties for 4200-UL-LS-XX, 4200-LC-LS-XX, and 4200-GP-RS-XX

Figure 21 shows the card properties for these switch matrix configurations. Set up each card in the system as shown in the
illustration. 

Each row and column has a drop-down menu to set the card properties. The rows are used for instrument assignments. Figure
21 shows Row G (CMTR1 Input) and Row H (CMTR1 Output) being used by the Model 590 CV Analyzer. If the Model 590
has not been added to the system, the CMTR1 Input and CMTR1 Output settings will not be available. The “4200-SCS
Reference Manual,” Appendix C, explains how to add the Model 590 to the system. If not using Rows G and H, set them to NC
(no connection). 

The columns are used for DUT pin assignments. Any available DUT pin may be assigned to any column. DUT pins may only
be assigned once. The total number of DUT pins is set in the test fixture or prober setup panel. The example in Figure 21 shows
Card 1 Columns to DUT pins 1 through 12, Card 2 Columns to DUT pins 13 through 24, and so on.

4200-UL-RS-XX card properties

Figure 22 shows the card properties for these switch matrix configurations. Set up each card in the system as shown in the
illustration.

NOTE When the instrument connection scheme is set to Remote Sense, a pair of terminals is required for 
each instrument and each DUT pin. This is why Figure 22 displays every other pin as a Sense 
Lead.

Each column has a drop-down menu to set the card properties. CARD 1 is used for instrument assignments. Figure 22 shows
Column 9 (CMTR1 HCUR) and Column 11 (CMTR1 LCUR) being used by the HP Model 4284A LCR Meter. If the Model
4284A has not been added to the system, the CMTR1 HCUR and CMTR1 LCUR settings will not be available. The
“4200-SCS Reference Manual,” Appendix D, explains how to add the Model 4284A to the system. If not using Columns 9 and
11, set them to NC (no connection). 

The Columns of the other cards are used for DUT pin-pair assignments. As shown, set CARD 2 Columns to DUT pins 1 through
6, CARD 3 Columns to DUT pins 7 through 12, and so on. 
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Figure 21
Card properties: 4200-UL-LS-XX, 4200-LC-LS-XX, and 4200-GP-RS-XX
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Figure 22
Card properties: 4200-UL-RS-XX
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Step 6. Save configuration
The KCON configuration is saved from the File menu. As shown in Figure 23, click Save Configuration. 

Figure 23
Save KCON system configuration 

Step 7. Close KCON and open KITE
KCON can be closed from the File menu by clicking Exit. It can also be closed by clicking the close button (X) at the top right-
hand corner of the KCON window.

On the windows desktop, double-click the KITE icon to open KITE. 

Deleting test fixture or probe station from the system
A test fixture and a probe station cannot be in the test system at the same time. If a test fixture is in the system, it will have to
be removed if you want to add a probe station. Conversely, if a probe station is in the system, it will have to be removed if you
want to add a test fixture. 

If a test fixture or probe station is in the system, it will be displayed in the System Configuration Navigator provided on the left
side of the KCON window. To delete an instrument, click Test Fixture - TF1 or Probe Station PRBR1 to select it, and then select
Delete External Instrument in the Tools menu. This procedure is illustrated in Figure 24. 

Figure 24
Removing a test fixture or probe station from the system configuration
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